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1. Getting Started 

Welcome to Guotai Junan FX! GTJAFX MT4 Client Terminal is a part of the Guotai 

Junan FX online trading system. It is installed on the trader's computer and 

intended for: below features: 

 

 receiving quotes and news in the online mode; 

 performing trade operations; 

 controlling and managing open positions and pending orders; 

 conducting technical analysis; 

 writing expert advisors, custom indicators, scripts, and functions in 

MetaQuotes Language 4 (MQL4); 

 testing and optimizing trading strategies. 

 

 

 

The Client Terminal can operate under Microsoft Windows XP 

(SP3)/2003/Vista/2008/7/8/10. A processor that supports SSE2 instruction sets is 

required for operating as well. Other hardware requirements depend on terms of 

using the terminal – load from running MQL4 applications, number of active 

instruments and charts, etc. 
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1.1 Terminal Installation 
To install Client Terminal, it is necessary to download its distributive and launch it. 

Download link: https://download.mql5.com/cdn/web/2909/mt4/gtjas4setup.exe 

Then it will be necessary to choose a directory for installing the program there 

and follow the Installation Wizard tips. After the terminal has been installed it 

will run automatically. 

 

 

 

1.2 Terminal Start 
After installation has been completed, a group of Client Terminal programs will 

be created in the "Start" menu, and the program shortcut will additionally 

appear on the desktop. They will help to start client terminal. 

 

  

 

To be authorized, it is necessary to tap “Login to Trade Account” in "File" menu. 

Then, enter your account number and password, and the server should be real 

account server “GTJAS-Main”. After all data have been specified, the "Login" 

https://download.mql5.com/cdn/web/2909/mt4/gtjas4setup.exe
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button should be pressed. 

If the "Keep personal settings and data at startup", option is enabled, the latest 

account used will be automatically authorized at the next start of the terminal. 

The "Keep personal settings and data at startup" option in terminal settings 

carries out the same action. 

 

1.3 OTP 
Use of OTP (One Time Password) provides an additional level of security when 

working with trading accounts. The user is required to enter a unique one-time 

password every time to connect to an account. 

To start using one-time passwords, you should bind your trading account with 

the password generator, which are the mobile terminals for iOS and Android. 

After binding a trading account to the generator, a one-time password will be 

additionally requested when connecting to it from the desktop terminal: 

 

 

 

1.4 Change password 
We suggest clients to change their password during first login, and change the 

password regularly. 

Please tap “Options” in "Tools" menu. In “options” window, click “Change” 

button to create new password. 
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Having pressed the "Change" button, one can specify new passwords in the 

window appeared. Doing so, one has to know the current password. It can be 

found in the message sent from the server after registration of a demo account. 

The new password is input in the corresponding field. If the "Change investor 

(read only) password" option is enabled, the investor (not master) password will 

be changed. 

 

 

 

1.5 Live Update 
The terminal checks for new versions of the program when it connects to the 

server. If a new version of any of the terminal components has been discovered, 

it will be automatically downloaded in the background mode. 
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2. User Interface 

Interface of the terminal includes the following components: 

 

 

 

 A Main Menu 

All commands and functions that can be executed in the client terminal are 

collected in its main menu. It contains: "File", "View", "Insert", "Charts", 

"Tools", "Window", "Help". 

 

 B Toolbars 

Four toolbars are built into the terminal: "Standard", "Charts", "Line 

Studies", and "Timeframes". The toolbars contain duplicated commands 

and functions of the main menu. However, these toolbars are 

customizable, so one can collect only mostly used widgets in them. 
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 C Market Watch 

This window contains the symbol list. Commands of this window allow to 

control trade positions and charts. 

 

 D Data Window 

This window shows information about prices, as well as indicators and 

expert advisors imposed. This data window does not allow to perform any 

actions. 

 E Navigator 

Open accounts, expert advisors, indicators, and scripts are grouped in the 

navigation window. The "Navigator" can help to control them promptly. 

 F Terminal 

Terminal is a multifunctional window intended for working with trade 

positions, news, account history, alerts, internal mail, and logs of the 

program and of expert advisors, as well. Moreover, the "Terminal" window 

allows to open and modify orders of different kinds and manage trade 

positions. 

 

Trade – in this tab, one can view the status of open positions and pending 

orders, as well as manage all trading activities. Besides, the total financial 

result for all open positions is published in this tab; 

Account History – history for all performed trade operations and balance 

without taking open positions into consideration are published here. The 

efficiency of all trade activities can be estimated with the results given in 

this tab; 
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News – all financial news incoming in the terminal can be viewed from this 

tab. This prompt information is indispensable for fundamental analysis; 

Alerts – various alerts can be viewed and set here. Any files executable in 

the operational environment (including wave files) and messages to be 

sent by email can be used as alerts; 

Mailbox – all message income in the terminal by internal email are stored 

here. Electronic messages are sent from here, as well; 

Expert Advisors – information about functioning of the attached expert, 

including opening/closing of positions, order modifying, the expert's own 

messages, etc., are published in this tab; 

Journal – information about terminal launching and about events during 

its operation, including all trade operations performed, is stored in the 

journal. 

 G Tick Charts 

A tick chart is the basis of data analysis. Besides price changes, various 

analytical objects can be located in the chart: line studies, technical and 

custom indicators, texts, and geometrical figures. 

 H Status Bar 

For additional information to be visualized, the status bar is used in the 

terminal. The status bar contains indicator of the server connection, 

amount of incoming and outgoing traffic, names of active template and 

profile, as well as command prompts and price data. 
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3. Trading 

The fundamental and simple rule of profitable trading at financial markets is to 

buy cheaper and sell dearer. Thus, the entire trading activities at financial 

markets come to the successive operations performed to sell or buy securities. To 

do so, one has to open, modify, and close trade positions. 

 

3.1 Open Positions 
Clients can execute trading order in Client Terminal, and manage open positions. 

 

The above screenshot is a real-time quote of EUR/USD, the market watch shows 

the correct time and price: Bid 1.28537 and Ask 1.28583. To execute EUR/USD 

trading order, client can right click the related currency pair in Market Watch. 

And then select “New Order”. Client, also, can select “New Order” in Chart 

window, Terminal, or Main Menu. 

  

 

 

3.2 Modifying of Positions 
The following orders are used in the terminal: Market order, Pending order, Stop 

Loss and Take Profit. 

 

Market Order 
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Market order is a commitment to the brokerage company to buy or sell a 

security at the current price. Execution of this order results in opening of a trade 

position. Securities are bought at ASK price and sold at BID price. Stop Loss and 

Take Profit orders (described below) can be attached to a market order. 

 

 

Pending Order 

Pending order is the client's commitment to the brokerage company to buy or 

sell a security at a pre-defined price in the future. This type of orders is used for 

opening of a trade position provided the future quotes reach the pre-defined 

level. There are four types of pending orders available in the terminal: 

 

Buy Limit – buy provided the future "ASK" price is equal to the pre-defined 

value. The current price level is higher than the value of the placed order. Orders 

of this type are usually placed in anticipation of that the security price, having 

fallen to a certain level, will increase; 

 

Buy Stop – buy provided the future "ASK" price is equal to the pre-defined value. 

The current price level is lower than the value of the placed order. Orders of this 

type are usually placed in anticipation of that the security price, having reached 

a certain level, will keep on increasing; 

 

Sell Limit – sell provided the future "BID" price is equal to the pre-defined value. 

The current price level is lower than the value of the placed order. Orders of this 

type are usually placed in anticipation of that the security price, having 

increased to a certain level, will fall; 

 

Sell Stop – sell provided the future "BID" price is equal to the pre-defined value. 
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The current price level is higher than the value of the placed order. Orders of 

this type are usually placed in anticipation of that the security price, having 

reached a certain level, will keep on falling. 

 

 

 

Note that: -) limit order price must be higher or lower than market price 4 pips 

 -) The order expiry setting is defaulted as no expiry. And the expiry 

value cannot less than 10 minutes. 

 

Stop Loss 

This order is used for minimizing of losses if the security price has started to 

move in an unprofitable direction. If the security price reaches this level, the 

position will be closed automatically. Such orders are always connected to an 

open position or a pending order. The brokerage company can place them only 

together with a market or a pending order. Terminal checks long positions with 

BID price for meeting of this order provisions (the order is always set below the 

current BID price), and it does with ASK price for short positions (the order is 

always set above the current ASK price). 
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To automate Stop Loss order following the price, one can use Trailing Stop. 

Take Profit 

Take Profit order is intended for gaining the profit when the security price has 

reached a certain level. Execution of this order results in closing of the position. It 

is always connected to an open position or a pending order. The order can be 

requested only together with a market or a pending order. Terminal checks long 

positions with BID price for meeting of this order provisions (the order is always 

set above the current BID price), and it does with ASK price for short positions 

(the order is always set below the current ASK price). 

 

 

Note that: -) zero value of “Stop Loss” or “Take Profit” means that no stop loss 

or take profit is set in the order. 

 

3.3 Trailing Stop 
Stop Loss is intended for reducing of losses where the symbol price moves in an 

unprofitable direction. If the position becomes profitable, Stop Loss can be 

manually shifted to a break-even level. To automate this process, Trailing Stop 

was created. This tool is especially useful when price changes strongly in the 

same direction or when it is impossible to watch the market continuously for 

some reason. 
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Trailing Stop is always attached to an open position and works in client terminal, 

not at the server like Stop Loss, for example. To set the trailing stop, one has to 

execute the open position context menu command of the same name in the 

"Terminal" window. Then one has to select the desirable value of distance 

between the Stop Loss level and the current price in the list opened. Only one 

trailing stop can be set for each open position. 

After the above actions have been performed, at incoming of new quotes, the 

terminal checks whether the open position is profitable. As soon as profit in 

points becomes equal to or higher than the specified level, command to place 

the Stop Loss order will be given automatically. The order level is set at the 

specified distance from the current price. Further, if price changes in the more 

profitable direction, trailing stop will make the Stop Loss level follow the price 

automatically, but if profitability of the position falls, the order will not be 

modified anymore. Thus, the profit of the trade position is fixed automatically. 

After each automatic Stop Loss order modification, a record will be made in the 

terminal journal. 

 

Note that: -) Trailing Stop works in the client terminal, not in the server (like 

Stop Loss or Take Profit). This is why it will not work, unlike the 

above orders, if the terminal is off. In this case, only the Stop Loss 

level will trigger that has been set by trailing stop. 

 -) Trailing Stop is processed once per tick. If multiple orders with 

Trailing Stop are open for one symbol, only the trailing stop of the 

latest open order is processed. 

 

3.4 Position Close 
To close a position manually, one has to execute the opened position context 

menu command of the "Terminal – Trade" window or double-click with the left 

mouse button on this position. If trade operations for a certain symbol are 

executed on request, one has first to receive quotes by pressing of the "Request" 
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button. This activates the button that allows to close position. 

 

3.5 Modifying and Deletion of Pending Orders 
If market situation has been changed, there can occur a necessity to delete a 

pending order. To do so, one has to execute the "Modify or Delete Order" 

pending order context menu command or double-click with the left mouse 

button on the status bar of the pending order in the "Terminal – Trade" window. 

The window that manages orders will open. To delete an order, the button of the 

same name must be pressed in it. Pending orders can also be deleted 

automatically at the time that has been given in the "Expiry" field. When a 

pending order has been deleted, the corresponding record will appear in the 

"Terminal – Account History" window. 
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4. Client Terminal Settings 

 

4.1 Languages 
The Client Terminal interface is multilingual. It can be represented in any available 

language. This feature makes the program not only easy-to-use, but also allows to 

reduce the amount of errors that occur during trading because of lack of 

understanding of foreign terms and notions. The list of all available languages can 

be found in the "View – Languages" menu. One can switch one's terminal to a 

language by selecting of this language in the list. The language can be changed 

actually only after restart of the terminal. 

 

4.2 Market Watch and Contract Specification 
Guotai Junan FX provides 29 currency pairs, including: G7 Currieries’ USD pairs 

and cross pairs, and offshore Renminbi. Market Watch allows to place market 

and pending orders and open new charts. At the right mouse button click in the 

"Market Watch" window, the context menu will appear where the following 

commands are available: 

 

 Hide/Show currency pairs 

Hide the symbol from the list. To minimize the traffic, it is recommended 

to hide unused securities from the quotes window by this command or by 

pressing of the Delete button. 

 Auto Arrange 

Automatic arranging of columns when changing the window size. Auto 

arrange can also be enabled by pressing A button. 
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 Sets 

Open the sub-menu that manages the symbol sets. The current set of 

symbols can be stored in this sub-menu, as well as delete or select an 

already existing one. This is very comfortable when working with 

securities of different types 

 Contract Specification 

The symbol contract specification window contains the terms of a symbol 

trading. To view the symbol properties, click "Specification" in its context 

menu in the "Market Watch" window. 

 
  



19 
 

5. Charts 

5.1 Chart Opening 
A chart shows the price changes for a security with the time. Charts are 

necessary for performing technical analysis, working of expert advisors and 

testing thereof. Up to ninety-nine charts can be opened in the terminal at the 

same time. 

A new chart can be opened by executing of the "File – New Chart" menu, 

"Window – New Window" menu command, or by pressing of the  button 

of the "Standard" toolbar. The list of symbols available will appear at performing 

any of the above actions. Having selected the necessary symbol from this list, 

one can open its chart. New charts can also be opened from the "Market Watch" 

window, holding Ctrl and dragging the element of the list (the symbol) from the 

window into any point of the workspace of the terminal, or having executed the 

"Chart Window" command of the context menu. 

 

5.2 Properties 
Execute the "Charts – Properties..." menu command, the chart context menu 

command of the same name, or press F8. These actions result in appearing of 

the "Properties" window that can be used for setting of the color of various 

elements of the chart (the "Colors") tab: 

 

 

Other chart settings can be defined in this window, as well. To do so, one has to 

switch to the "Common" tab and select the desired options: 

 Offline chart – turn the chart offline. This option stops receiving and 

drawing of price data for the given chart. In future, after this option is 
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disabled, price data will be drawn in the chart again. After the chart has 

been opened offline, (the "File – Open offline" menu command), this 

option will be enabled automatically. 

 Chart on foreground – place the chart in the "foreground". If this function is 

enabled, all analytical objects will be placed "under" the price chart. 

This command is the same as that of "Charts – Foreground chart". 

 Chart shift – shift the chart from the right border of the window to the shift 

mark. The chart shift mark (a gray triangle in the upper part of the 

window) can be moved with the mouse horizontally within 10 to 50% of 

the window size. 

This option can also be enabled with the  button of the "Charts" 

toolbar or by the "Charts – Chart Shift" menu command. 

 Chart auto scroll – allow/forbid to shift the chart to the left automatically 

after the new bar has started to form. If this option is enabled, the latest 

bar will always be shown in the chart. 

This option can also be enabled by the  button of the "Charts" 

toolbar and by the "Charts – Auto Scroll" menu command. 

 Scale fix One to One – fix the chart scale as "one to one" (the size of one 

pip of the vertical axis in pixels is equal to the distance between the bars 

axes in pixels). At that, the "Scale fix" option will be enabled automatically, 

and a scroll bar will appear at the right side of the window that allows to 

move the chart vertically. This mode is necessary for precise 

constructions. 

 Scale fix – fix the current chart scale. If the scale has not been fixed, the 

chart will be automatically scaled vertically. This option disables 

automatic scaling and fixes the current scale. When this option is selected, 

the fields of additional scaling parameters "Fixed maximum" and "Fixed 

minimum" are activated. 

 Bar chart – display the chart as a sequence of bars. 

This action can also be performed with the  button of the "Charts" 

toolbar, by the "Charts – Bar Chart" menu command or by pressing 

of accelerating keys of Alt+1. 

 Candlesticks – display the chart as a sequence of candlesticks. 

This action can also be performed with the  button of the "Charts" 
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toolbar, by the "Charts – Candlesticks" menu command, or by pressing 

of accelerating keys of Alt+2. 

 Line chart – display the chart as a broken line that connects the points of 

bar close prices. 

This action can also be performed by the  button of the "Charts" 

toolbar, by the"Charts – Line Chart" menu command, or by pressing 

of accelerating keys of Alt+3. 

 Show OHLC – show/hide OHLC line. If this action is done, an additional data 

line will appear in the upper left part of the window. Except for symbol 

name and chart period, the latest bar prices are listed in it. Price are 

recorded in the following format: OPEN, HIGH, LOW and CLOSE (OHLC) – 

bar open price, the highest bar price, the lowest bar price, and bar close 

price, respectively. Thus, precise value of the latest bar can always be 

seen. This option influences the data line of sub-windows of indicators, as 

well. 

 Show Ask line – show/hide Ask price level of the latest quote. Bars are 

drawn and shown only on Bid prices in the terminal. However, at opening 

of long positions and closing of the short ones, the Ask price is always 

used. It is not shown in the chart in any way, so it cannot be seen. To 

control one's trading activities more precisely, one can enable the "Show 

Ask line" parameter. After this command has been executed, an additional 

horizontal line will appear in the chart that correspond with the Ask line 

of the latest bar. 

 Show period separators – show/hide period separators. Date and time of 

each bar are displayed on the horizontal axis of the chart. And this 

horizontal scale interval is the selected timeframe. The "Show period 

separators" option draws additional vertical lines in the chart that 

correspond with the larger period (timeframe) borders. So, daily 

separators will be drawn for charts with periods of M1 to H1, weekly 

ones – for H4, monthly ones – for D1, and yearly ones – for W1 and MN1. 

 Show grid – show/hide grid in the chart window. 

The same actions can be performed by the chart context menu 

and "Charts" menu command of the same name, as well as by pressing 

of accelerating keys of Ctrl+G. 

 Show volumes – show/hide the volume chart in the lower part of the 

window. This option does not function when the scale is fixed. 

The same actions can be performed by the chart context menu 
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and "Charts" menu command of the same name, as well as by pressing 

of accelerating keys of Ctrl+L. 

 Show object descriptions – show/hide object descriptions in the chart. If 

this option is enabled and there are descriptions of objects imposed into 

the chart available, they will be shown directly in the chart. 

 
 

5.3 Chart Management 

 Chart Type 

A symbol chart can be of three types: 

 Bar Chart – the sequence of bars. 

To make a chart of this type, one has to press the  button of 

the "Charts" toolbar, accelerating keys of Alt + 1, the 

corresponding option of the Charts Setup window, or execute 

the "Charts – Bar Chart" menu command. 

 Candlesticks – the sequence of candlesticks. 

To make a chart of this type, one has to press the  button of 

the "Charts" toolbar, accelerating keys of Alt + 2, the 

corresponding option of the Charts Setup window, or execute 

the "Charts – Candlesticks" menu command. 

 Period Change 

The client terminal allows to use nine different data periods, from a minute 

to a month long. This variety of periods is necessary for analyzing the 

market with technical indicators and line studies. 
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The desired period of the chart can be chosen with help of the "Period" 

toolbar, the  button of the "Charts" toolbar, the "Charts – Period" 

menu, or by executing of the chart context menu command. 

 Saving 

The client terminal allows to save history data of the active chart as a text 

file in formats of "CSV", "PRN", and "HTM". To save them in one of these 

ways, one has to execute the "File– Save As" menu command or press 

accelerating keys of Ctrl + S. Besides, the chart can be saved as a picture in 

BMP or GIF format. To do so, one has to execute the "File–Save As 

Picture..." menu command. The same actions can be performed by the 

chart context menu command of the same name. 

 Print 

To print the active chart in color, one has to flag "Color print" in the chart 

settings, then execute the "File – Print..." menu command, the chart 

context menu command of the same name, press the  button of 

the "Standard" toolbar or accelerating keys of Ctrl+P. If the "Color Print" is 

disabled, or there is no color printer available, the chart will be printed as 

black-and-white. 

 Zooming 

Charts can be zoomed horizontally, increasing or decreasing thereby the 

amount of bars shown in the screen simultaneously. 

To do it, one can use the buttons of /  of the "Charts" toolbar, keys of 

"+"/"-", the commands of "Zoom In"/"Zoom Out" of the chart context menu 

and of the "Charts" menu. 

To zoom out a chart vertically, one can hold any point of vertical axis with 

the left mouse button and move it down. Double click on vertical axis or 

pressing of "5" in the keypad restores the scale. 

 Scrolling, Auto Scrolling, and Shifting of the Chart 

Scrolling is moving of price data to the right/left in the chart that can be 

performed by cursory keys of the keyboard. Besides, the chart can be 

scrolled with F12 (the "Step by Step" mode – scrolling the chart by one bar 

to the left) or Shift+F12 (scrolling the chart by one bar to the right), or with 

the mouse: one moves the cursor to the right/left when holding the left 

mouse button pressed on any point of the chart. Using the fast navigation 

box, one can have shown the necessary area of the chart having specified 



24 
 

the specific date and time. If the chart has been scrolled to the area where 

there are no price data, the missing bars will be downloaded automatically. 

Auto scroll is intended for users to have the latest bars before their eyes 

constantly. If this option is enabled, the chart will be automatically scrolled 

to its end part. This function can be enabled by pressing of the  button 

of the "Charts" toolbar or by the "Charts – Auto Scroll" menu command. 

The "Chart Shift" option shifts the latest bar from the right screen border to 

the chart shift mark. The chart shift mark (a gray triangle in the upper part 

of the window) can be moved horizontally with the mouse within 10 to 50% 

of the window size. The chart shift can be enabled by the  button of 

the "Charts" toolbar or by the "Charts – Chart Shift" menu command. 

 Working with Templates 

Templates represent the chart window parameters stored in the memory. 

The following is saved in a template: chart type, period, scale, all settings of 

line studies, technical and custom indicators, and experts. Templates allow 

to unify the appearance of many charts easily and fast. 

The menu that manages templates can be called by the "Charts – Template" 

menu command, the chart context menu command of the same name and 

the  button of the "Charts" toolbar. The "Save Template..." menu 

command allows to store a new template, and that of "Remove Template" – 

to delete an existing one. 

More details can be found in the "Templates and Profiles" section. 

 Working with Profiles 

Profiles represent a convenient way of working with chart groups. At 

opening of a profile, each chart with all its settings will be found in the 

same place where it was when the profile was being stored. 

The menu that manages profiles can be opened by the "File – Profiles" 

menu command, by pressing of the  button of the "Standard" toolbar, 

or by clicking with the mouse in the status bar containing the name of the 

current profile. 

More details can be found in the "Templates and Profiles" section. 

 Data Updating 

Data must be updated if any errors or "holes" occur in the price chart. In 

order to update the price data, one has to execute the "Charts – Refresh" 
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menu command or the chart context menu command of the same name. 

After all these actions have been performed, the missing bars will be 

downloaded from the server automatically and drawn in the chart. 

 Data Updating 

Data must be updated if any errors or "holes" occur in the price chart. In 

order to update the price data, one has to execute the "Charts – Refresh" 

menu command or the chart context menu command of the same name. 

After all these actions have been performed, the missing bars will be 

downloaded from the server automatically and drawn in the chart. 

 Deleted Charts 

This can be done by the "File – Close" menu command or by pressing of 

accelerating keys of Ctrl+F4. At that, the templates of deleted windows will 

be stored if "Save deleted charts to reopen" is enabled in the client terminal 

settings window. These templates can be used in future. So, if a chart has 

been deleted occasionally, it can be restored. To do so, one has to execute 

the "File – Open Deleted" menu command and select a symbol from the list. 

After that, the chart window of the selected symbol will be fully restored 

with all its settings and objects imposed into it. 

 

5.4 Technical Analysis 
Technical indicator is a mathematical manipulation of a security price and/or 

volumes aimed at forecasting of future price changes. This platform provides 

over fifty technical indicators including MACD, RSI, and Moving Average. 

Investor can open it by execution of the "Insert – Indicators" menu command. 

 

5.5 Line Studies 
Line studies are lines and various geometrical shapes that can be imposed into a 

price or indicator chart. They include support/resistance lines, trend lines, as 

well as Fibonacci's, Gann's, and Andrews' tools, etc. 

Line studies are collected in the "Insert" menu and in the "Line Studies" toolbar 

in terminal. To impose an object, one has to press the corresponding toolbar 

button (the buttons are given in the leftmost column of the table) or execute a 

menu command. 
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5.6 Templates 
A template is a set of chart window parameters that can be applied to other 

charts. The following can be stored in a template: 

 chart type and color; 

 color diagram; 

 chart scale; 

 OHLC line shown or hidden; 

 the attached expert advisor and its parameters; 

 the imposed custom and technical indicators with their settings; 

 line studies; 

 separators of days. 

 

When a template is imposed into a chart, the stored settings, as they are, will be 

attached to the security and period. For example, one can create a template 

that includes indicators of MACD, RSI, and Moving Average, and then use it for 

other charts. In this case, charts windows will have the same view for different 

symbols and periods. 

Templates are stored in the /TEMPLATES directory as TPL files. A template 

created once can be used unlimited amount of times. A basic template 

(DEFAULT.TPL) is created during installation of the terminal. It will be applied 

automatically for creation a new chart window. In future, it can be changed by 

using of the active chart window properties. 

To create a new template, one has to execute the "Charts – Template – Save 

Template..." menu command, the chart context menu command of the same 

name, or by pressing of the  button of the "Charts" toolbar. As a result, a 

new template will be created on basis of the data of active chart window. The 

same actions must be performed to modify a template, but an existing template 

should be selected instead of entering of a new filename. To impose a template 
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into the chart window, one has to select the desired file in the templates 

managing menu or in any available folder in the "Open" window that can be 

called by the "Charts – Template – Load Template..." menu command. 

The "Charts – Template – Remove Template" menu command and the chart 

context menu command of the same name allow to delete templates. 
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6. Auto Trading 

To work at financial markets more effectively, one can develop one's own 

successful system of trading. It is very difficult to act within a chosen system of 

trading in the manual mode due to significant influence of normal human 

emotions. Mechanical trading systems do not suffer from this disadvantage. 

 

MetaQuotes Language 4, MetaEditor and strategy testing tools are built in the 

terminal. One can create the following using these means: 

 

 Expert Advisors – mechanical trading systems that allow complete 

automation of analytical and trading activities; 

 Custom Indicators – independently written technical indicators intended 

for analyzing of price changes; 

 Scripts – programs to be executed only once, on request. 

 

6.1 MetaQuotes Language 4 
MetaQuotes Language 4 (MQL4) is the language for programming of trade 

strategies built in the client terminal. It allows to write custom expert advisors 

that automate trade processes and ideally suit for implementation of traders' 

own strategies. Moreover, traders' own custom indicators, scripts and DLL's can 

be created in MQL4. 

 

Syntax of MQL4 is quite similar to that of C language. A large amount of 

functions necessary to analyze quotes, manage positions, call technical 

indicators, and others, are included in MQL4. The MetaEditor, an editor for 

expert advisors, is used for writing the source code of programs. The 

MetaQuotes Language Dictionary that contains descriptions of all language 

constructions and functions is built in the editor. 

 

Programs written in MQL4 are different in tasks and properties: 

 Expert Advisor is a mechanical trading system (MTS) to be run when a new 

tick incomes. It can work not only in the mode alerts, but also perform 

trade operations independently. Terminal allows to test trading 

strategies on history data in order to detect the expert features under 

different market conditions; 
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 Custom Indicator is a technical indicator written individually. Custom 

indicators are used only for analyzing of price changes; 

 Script is a program that is intended for a single execution of some actions. 

Unlike experts, scripts are launched not tick by tick, but on a command. 

 

6.2 MetaEditor 
MetaEditor is a constituent of the client terminal. It is intended for creation, 

editing, and compilation of program source codes written in MetaQuotes 

Language 4 (MQL4). It can be used in developing of experts, custom indicators, 

scripts and DLL's. 

 

Expert Advisors Wizard is built in the editor to assist in fast creation of new 

MQL4 programs. The new file will be saved in the corresponding folder of the 

client terminal automatically. Templates can be used in creation of an MQL4 

program, as well. After that, one can start writing the program text. The 

supplemental information can be found in MQL4 Dictionary. The full description 

of the language with examples of how to use it is given there. After the program 

has been written, one has to compile it in MetaEditor. As a result of successful 

compiling, the executable program code will be created that can be launched or 

tested in the terminal. 

 

A detailed description of MetaEditor can be found in its Help Files. 

 

6.3 Expert Advisors 
Expert Advisors (experts) are programs in the terminal that have been developed 

in MetaQuotes Language 4 (MQL4) and used for automation of analytical and 

trading processes. They allow to perform prompt technical analysis of price data 

and manage trading activities on basis of signals received. The entire routine 

work of technical analysis and trading can be given to experts. An expert can 

perform analytical and trading operations for any symbols or periods 

independent on whether the corresponding chart was opened or not. 

 

Working with experts means: 

 Creation of an Expert 

To create and compile an expert, one has to use the built-in "MetaEditor". 

It is a constituent of the client terminal and represents a convenient 

development environment of MQL4 programs. 
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 Expert Setup 

Before using of experts, one has to set up them first. Working parameters 

common for all experts are set in the client terminal settings. Besides, 

each expert can have its own settings. 

 Launch of an Expert 

To launch an expert, one has to impose it into the chart. As soon as a new 

tick incomes, the expert will start executing. 

 Expert Shutdown 

An expert advisor is shut down after it has been removed from the chart. 

 

6.4 Scripts 
Script is a program written in MetaQuotes Language 4 (MQL4) and intended for 

a single performing of any actions. A script can fulfill both analytical and trading 

functions. Unlike experts, scripts are executed on request, not by ticks. In other 

words, where an expert works almost continuously, a script, having completed 

the function once, stops functioning by itself. 

 

Working with scripts means: 

 Creation of a Script 

The built-in "MetaEditor" is used to create and compile a script. It is a 

constituent of the client terminal and represents a convenient 

development environment of MQL4 programs. 

 Script Setup 

One has to set up scripts first before using them. Working parameters 

common for all scripts are defined in the client terminal setup window. 

Every script has its own settings, as well. 

 Launching of a Script 

To launch a script, one has to attach it to the chart. The script algorithm 

will be launched immediately after that. 

 Deletion of a Script 

The script completes its working after it has been deleted from the chart. 
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7. Other Tools 

7.1 History Center 

 

Technical analysis is the market movements research made in order to forecast 

future price movements. The market is often analyzed using charts. So it is very 

important to have available historical data for all symbols and timeframes used. 

Historical data are constantly formed and stored on the server. Connecting to it, 

the client terminal downloads all necessary data. They will be then used for 

drawing of charts, testing and optimization of Expert Advisors. To control 

historical data, the terminal has a special window named "History Center". This 

window can be opened by executing the command "Tools – History Center" or by 

pressing F2. 

In the "History Center" window, the available data can be changed. For this, it is 

necessary to select the desired symbol and timeframe in the left part of the 

window. The corresponding data will be loaded in form of a table. To add a 

record about a new bar, it is necessary to press the button of the same name, fill 

out all necessary fields in the new window and press "OK". After that, the new 

bar will appear in the history. One can modify the bar by selecting the 

corresponding record and pressing the "Modify" button. To delete a bar, it is 

necessary to select it and press the button of the same name. 
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8. Technical Support 

For further support on the terminal, client can click “Help Topics” in “Help” menu 

or click F1. If you have any question, also, please feel free to contact Guotai Junan 

FX by email or phone: 

 

Dealing / CS: (852) 2509 9788 

Fax: (852) 2509 4006 

Email: fx@gtjas.com.hk 

Website: www.gtjas.com.hk/fx.html 

mailto:fx@gtjas.com.hk

